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1. Tips before submitting 
Aim to submit your assignment a minimum of 3 hours before the submission deadline to allow time to 

resolve any problems you encounter with submitting.  It is your responsibility to ensure that the correct 

document is uploaded before the submission deadline. 

 

Your Hub Info Point (https://www.exeter.ac.uk/students/infopoints/contact/) is open from 

9.00am – 5.00pm Monday to Friday (except in University closure days) to assist with queries.  

 

 

Also see guidance at 

https://www.exeter.ac.uk/students/infopoints/yourinfopointservices/assessments/  

 

 

If you are using a computer or laptop outside of the University grounds please ensure you have a secure, 

strong internet connection before submitting online. 

Your College will decide whether assignments are printed in black and white or colour.  This will be 

indicated clearly.  Make sure you consider this when formatting your assignment. 

 

PLEASE NOTE THAT EXTENSIONS WILL NOT BE GIVEN IF YOU ENCOUNTER ANY PROBLEMS AND HAVE NOT 

ALLOWED A REASONABLE AMOUNT OF TIME TO SUBMIT BEFORE THE SUBMISSION DEADLINE  

  

https://www.exeter.ac.uk/students/infopoints/contact/
https://www.exeter.ac.uk/students/infopoints/yourinfopointservices/assessments/
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2. Formatting requirements checklist 
 

BEFORE YOU SUBMIT please complete the format checklist below. If your assignment meets all of the 

criteria, then you will be ready to submit (see Section 3). 

 

Check Yes No 

Which format has your module 
convenor specified for 
submission?  

PDF 

 Is your assignment saved in PDF 
format using one of the 
recommended PDF writers?  
 
Recommended PDF writers:  
 

 Microsoft Word 2010, 2013, 
2016, 2019 

 Mac Office 2008 & 2011 

 PDF Creator 

 CutePDF.com 

 
Non PDF 
 
Word (.doc, .docx) 
Excel (.xls, .xlsx) 
PowerPoint (.ppt, .pptx) 
MP3 (.mp3) 
M4A (.m4a) 
WMA (.wma) 
MP4 (.mp4) 
ZIP (.zip) 
 

OK for 
submission 

Please re-save your work using one of the 
recommended PDF writers (see Section 4).  
If you do not use one of the recommended PDF 
writers we cannot guarantee your submission will 
print correctly. 
Microsoft Word 2010/2013 and PDFCreator are 
installed on all university computers.  

A4 format – Is your assignment 
saved in A4 format? 

OK for 
submission. 

Please re-save your work in A4 format. A3 etc files 
will not be accepted. 

File size - Is your file size below 
100MB?  

For information on how to check 
your file size, see Section 4.8 

OK for 
submission 

Please reduce your file size. If your file contains 
pictures you can compress these using the 
‘compress pictures’ button on the tools/format bar. 

If you cannot reduce your file size please contact 
your Info Point. 

Single file – Is your assignment in 
one single file?  

OK for 
submission 

Combine all your separate files into one single file 
then recomplete the format checklist. 

https://www.exeter.ac.uk/students/infopoints/contact/
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3. Submitting Online 

3.1. LOCATING YOUR ASSIGNMENT 
 

STEP 1:  Log into BART directly at https://bart.exeter.ac.uk or via ELE. 

To log in via ELE, click the ‘Quick Links’ drop down menu at the top of the screen, and then click ‘BART Cover 

Sheets’ (see Figure 1 below). 

 

 

 

 

 

 

 

 

 

 

STEP 2:  Locate your assignment from the schedule list. There will be a click-button beside it: either ‘Print 

cover sheet’ or ‘Submit online’. 

If the button says 'Print cover sheet', your assignment cannot be submitted electronically and you will need 

to be submit a paper copy by printing your BART cover sheet, attaching this to your assignment and handing 

it in at your allocated submission point. 

If the button says 'Submit online' then your assignment will need to be submitted electronically (see Figure 

2).  

Font - Have you used the correct 
font size and style specified in 
your assignment instructions? 

OK for 
submission 

Please change your font to the required size and 
style. See your College handbook for details. 

FIGURE 1 

https://bart.exeter.ac.uk/
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3.2. UPLOADING YOUR ASSIGNMENT 
 

STEP 3:  Click on the ‘Submit online’ button. This will take you to a ‘Submit assignment online’ screen (see 

Figure 3.1 and 3.2 below). 

       FIGURE 3.1 – PDF submission 

  

  

FIGURE 2 
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FIGURE 3.2 non PDF submission 

 

 

STEP 4:  Input the relevant details into the boxes provided then upload your assignment by clicking on the 

‘Choose file’ button. 

STEP 5: A pop-up ‘Open’ dialogue box will appear (see Figure 4).  Select the document you wish to upload 

and click ‘Open’.  

 NOTE: Please ensure that your document complies with the formatting requirements checklist (see 

Section 2) otherwise your submission may be rejected. 

 

 

 

 

 

 

 

 

 

 

FIGURE 4 
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3.3. SUBMITTING YOUR ASSIGNMENT 
 

STEP 6: When you have selected your file, click on the ‘Submit assignment’ button. 

STEP 7: A submission confirmation message, ‘UPLOAD COMPLETE!’ should appear on your screen showing 

your electronic submission receipt (see figure 5 below).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You will also have the option to view your submitted assignment by clicking on the ‘View final submission 

with cover sheet’ link. 

 NOTE: It is your responsibility to ensure that the correct document has been uploaded before the 

submission deadline 

 NOTE: If you submit your assignment before the submission deadline, you will have the option to 

resubmit your assignment. See the ‘Resubmission Section’ below. 

 NOTE: Your cover sheet will have been added to your submitted document when you view it. 

 NOTE: You will have the option to view your assignment at any time after you have submitted it (see 

Section 3.4) 

  

FIGURE 5 
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STEP 8: You should also receive a BART receipt via your University email account confirming receipt of your 

submission (see Figure 6). You should check your University email to make sure that you have received a 

BART receipt.  

 

 

 

 

 

 

 

 

 NOTE: If a submission confirmation page appears on your screen but you do not receive an email 

receipt, please contact your Info Point to check that your submission has been successful. 

 NOTE: You can also check whether your assignment has been submitted by looking at your BART 

schedule which will have the time and date of submission beside your assignment (see Figure2). 

 

 

3.4. VIEWING YOUR ASSIGNMENT 
STEP 9: You will have the option to view your assignment at any time after you have submitted it. On your 

BART schedule, a button option will appear beside your assignment labelled 'View submission' (see Figure 7 

below). Click on this to view your assignment.  

 

 

 

 

  

FIGURE 7 

FIGURE 6 

https://www.exeter.ac.uk/students/infopoints/contact/
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3.5. UPLOAD FAILED PAGE 
 

If your assignment is not accepted, an ‘UPLOAD FAILED!’ page will appear on your screen (see below).  It will 

have 1 of 4 messages underneath stating possible reasons for the failed upload.  

a) File size 

 

 

For more information on how to reduce you file size, see Section 0 

b) PDF format 

 

 

For more information on saving PDFs, see Section  

c) Formatting 

 

 

For more information on formatting requirements, see Section 2. 

d) Resaving PDF 

 

 

 

 

 

 

For more information on re-saving PDFs, see Section 0 

You should follow the instructions on the UPLOAD FAILED page and re-check that you have complied with all 

the formatting requirements listed at the beginning of this document (see Section 2) and then try submitting 

your assignment again following steps 1-8.   

If you have followed all formatting requirements and the upload still fails, try converting your original file 

again using a different recommended PDF writer. 

If your assignment is still not accepted, please contact your Info Point for further assistance. 

  

https://www.exeter.ac.uk/students/infopoints/contact/
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3.6. RESUBMISSION 
 

You have the option to re-submit your assignment as many times as you wish before the submission 

deadline. 

To re-submit, log into BART and locate your assignment again on the BART schedule. 

There will now be a button labelled ‘Re-submit online’ (see Figure 8). 

 

 

 

 

 

Click on the ‘Re-submit online’ button.  This will take you to a ‘Re-submit assignment online’ screen (see 

Figure 9). 

 NOTE: The new assignment you submit will overwrite your previously submitted assignment. 

FIGURE 9 

 

Now follow the steps in Section 3 again as if you were submitting for the first time ensuring that you have 

complied with the formatting requirements (see checklist, Section 2). 

  

FIGURE 8 
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When you click on the ‘Submit assignment’ button a warning message will appear reminding you that your 

new submission will overwrite your previous submission (See Figure 10).  If you are happy with this click OK. 

If not click cancel which will take you back to the ‘Re-submit assignment online’ screen. 

 

 

 

 

 

 NOTE: If the submission deadline has passed and you have already submitted an assignment, you will 

not be able to re-submit your assignment.  The ‘Re-submit online’ button in the ‘Online submission’ 

column on your BART schedule, will have been replace with the message ‘Deadline passed’. How to 

save your assignment in PDF format (including recommended PDF writers) where required. 

 

*All university PC Clusters have either Microsoft Word 2013 or Word 2010 installed. * 
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4. How to save your assignment in PDF format 
 

4.1. MICROSOFT WORD 2010 
 

 Open your assignment submission file in Microsoft Word. 

 In the File tab, click on Save As in the Navigation pane. Then, in the Save As dialogue box, access the 

Save as type drop-down menu by clicking on the little arrow (see Figure 11 below). 

 

 

 

 

 

 

 

 

 

 Select ‘PDF (*.pdf)’ 

 Select your desired folder location  

 

 

 

 

 

 

 

 

 

 

 

 

  Now click the ‘Save’ button. 

  

FIGURE 11 

Select your desired location for saving the 

document here 

Access the drop-down 

menu by clicking the 

little arrow 

Select  FIGURE 12 
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4.2. MICROSOFT WORD 2013 

 Open your assignment coursework file in Microsoft Word. 

 Click on the File tab, select a file location in the main pane (e.g. Desktop) (see Figure 13).  

 

 

 

 

 

 

 

 

 

 

 

 This will bring up a ‘Save As’ dialogue box (see Figure 14).  

 Check the file location in the address bar at the top of the dialogue box. If required, you can change 

this location by selecting an alternative from the drop-down menu.  (Access the menu by clicking on 

little black downward-pointing arrow at the end of the bar.)  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

FIGURE 13 

FIGURE 14 
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 Next select PDF (*.pdf) from the Save as type drop-down menu  

 

 

 

 

 

 

 

 

 

 

 Now click the ‘Save’ button (see Figure 15).  

 Your file will now be saved as a pdf file in your chosen location. 

 

 

4.3. MAC 2008/2011 

 Open up your file in Microsoft Word. 

 Click on the ‘File’ tab and then ‘Save As’ in the navigation pane. 

 A dialogue box will appear (see Figure 16). 

 Select PDF from the format drop-down menu 

 Select the desired folder location and then click ‘Save’.  

 

 

 

 

 

 

 

 

  

FIGURE 16 

FIGURE 15 
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4.4. PDF Creator 

 Open up your file in Microsoft Word. 

 Click on ‘File’ tab and then ‘Print’ in the navigation pane (see Figure 17). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 In the drop-down menu under ‘Printer’ select ‘PDFCreator’.  

 Click on the ‘Print’ button. 

 A ‘PDF Creator’ dialogue box will appear (Figure 18) 

 

 

 

 

 

 

 

 

 

 

Click on ‘Save’  

  

FIGURE 17 

FIGURE 18 
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 A ‘Save as’ dialogue box will now appear (Figure 19).  Select the desired folder location from the 

drop-down menu and click ‘Save’.  

 

 

 

 

 

 

 

 

 

 

 

 NOTE: All university PC Clusters have PDF Creator installed  

 

 

4.5. CutePDF 
 Open up your file in Microsoft Word. 

 Click on the ‘File’ tab and then ‘Print’ in the left hand column  

 In the drop-down menu under ‘Printer’ select ‘CutePDF’ (see Figure 20) 

 

 

 

 

 

 

 

 

 

 

 

FIGURE 19 

FIGURE 20 
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 Then click on the ‘Print’ button 

 A ‘Save As’ dialogue box will appear  (see Figure 21) 

 

 

 

 

 

 

 

 

 

 

 Select the desired folder location and click ‘Save’.  

 

 NOTE: CUTE PDF is available here   http://www.cutepdf.com/ 

 NOTE: Assignments converted to pdf file format using PrimoPDF creator will NOT upload 

 

 

4.6. SAVING A PDF FROM AN EMAIL 
 

When opening a PDF attachment from an email, ensure that you save it in the correct pdf format. To do this, 

right click on the file and then select ‘Save As’ (see Figure 22) - rather than double clicking on the attachment 

to open and then save the file.  

 

 

 

 

 

  

FIGURE 21 

FIGURE 22 

http://www.cutepdf.com/
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4.7. DO NOT re-save PDFs 
Once you have saved your file as a pdf, please do not re-save the pdf as the file will be rejected when it is 

uploaded.  

 

If you want to make changes (e.g. save the file with a different file name), please make the changes to the 

original Word file and then re-save the updated Word file as a PDF. Do not re-save the PDF itself in Adobe 

(see Figure 23). 

 

 

 

 

 

 

 

 

 

 

4.8. CHECKING YOUR FILE SIZE 
To check your file size of a PDF click on ‘File’ and then select ‘Properties’ from the drop down list (see Figure 

24). 

 A pop-up ‘Document Properties’ dialogue box will appear (see Figure 25).  The file size of your pdf will be 

shown here under ‘File Size’.  

 

 

 

 

 

 

 

 

 

 

FIGURE 23 

DO NOT select the file and 

click on ‘Save As’ to re-save 

your pdf. Close the pdf, go 

to your original Word file 

and re-save this as a pdf.  

FIGURE 24 

FIGURE 25 
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4.9. REDUCING YOUR FILE SIZE 
NOTE: Make sure you have checked your file size once it is in PDF format. PDF files are generally much 

smaller than Word files. 

Compressing pictures 

If you have images in your assignment Word document, you can reduce your file size by compressing these 

images.  

Click on the image in your Word file and then in the ‘Format’ tab of ‘Picture Tools’, select ‘Compress 

pictures’ (see Figure 26). 

 

 

 

 

 

 

 

 

 

  

FIGURE 26 
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A ‘Compress Pictures’ dialogue box will appear (see Figure 27).  

Under the ‘Change resolution’ Section select ‘Print’.  

Under the Section ‘Apply to’ you have the option to apply this to ‘All pictures in document’ or only ‘Selected 

pictures’.  

Once you have chosen your desired settings click ‘OK’. 

Convert your Word file to a PDF and then re-check your file size (see Section 0) 

 

 

 

 

 

 

 

 

 

 

 

5. Coursework feedback 

5.1. CHECKING FOR ADDITIONAL FEEDBACK 

When you receive your assignment result, you will receive a feedback sheet. There may be additional 

feedback files in BART and/or additional paper feedback. You will normally receive an advisory email from 

your College/department if there is any additional feedback for you to view/collect. 

 

It is advisable to use Adobe Reader to view your PDF feedback sheet as this will show all comments and 

annotations fully. 

  

FIGURE 27 
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6. FAQs 
 

What if I submit my assignment but the submission confirmation page does not appear?  You can also 

check to see if your assignment has been submitted by looking at your BART schedule which will have the 

time and date of submission beside your assignment. You should also have received an email receipt 

confirming your submission. If you have not received an email and the time and date of submission is not 

beside your assignment please re-submit your assignment. If the problem persists contact SID 

(sid@exeter.ac.uk) or your College/School office. 

 

What if I do not receive an email receipt confirming my submission? Check your junk/spam folder to see if it 

has gone into there. If there is no email check to see if your BART schedule has the time and date of 

submission beside your assignment. If it does contact the IT helpdesk to alert them that you have not 

received an email confirmation. If the date and time of submission does not appear beside your assignment 

on your BART schedule please resubmit your work and check your emails again. If the problem persists 

contact your Info Point. 

 

What do I do if my file is rejected? Follow the UPLOAD FAILED instructions that appear (see Section 0) and 

ensure you have completed the format checklist (see Section 2) and then try re-submitting your assignment.  

 

What do I do if my assignment file keeps being rejected? If you have completed the format checklist (see 

Section 2) and followed the UPLOAD FAILED instructions (see Section 0) but the problem still persists, contact 

your Info Point.   

 

What are the recommended PDF writers? The recommended PDF writers are Microsoft 2010, 2013 2016, 

2019, Mac 2008, Mac 2011, Libre Office, Open Office, PDFcreator and CutePDF (free online).  All university 

computers have Microsoft Word 2010 or Microsoft Word 2013 and PDFcreator installed (see Section ).  

How do I save my assignment in PDF format (if required)? See Section  

How do I check the file size of my assignment? See Section 0 

What do I do if my file size is too large? PDF files are generally much smaller than Word files so check the file 

size of your assignment after you have converted it to a PDF file. For ways to reduce your file size (see 

Section 0). 

 What if I try to submit my assignment before the deadline but my submission fails and then the 

submission deadline passes?  It is your responsibility to submit your assignment with enough time to 

account for any problems that may occur. Please ensure that you complete the format checklist before 

submitting your assignment. Your Hub Info Point 

(https://www.exeter.ac.uk/students/infopoints/contact/) is open from 9.00am – 5.00pm Monday to 

Friday (except in University closure days) to assist with queries. Also see guidance at 

https://www.exeter.ac.uk/students/infopoints/yourinfopointservices/assessments/  

mailto:sid@exeter.ac.uk
https://www.exeter.ac.uk/students/infopoints/contact/
https://www.exeter.ac.uk/students/infopoints/contact/
https://www.exeter.ac.uk/students/infopoints/yourinfopointservices/assessments/

